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Introduction

Notice and Disclaimer

¢  This manual is intended to assist installersand operators in the safe and efficient installation

and use of the SOFTWARE described herein.

%*  Beforeattemptingto install and use the system, the installer / user must read this manual and
become familiar with all limitation, requirements and operating procedures.

%  Thesoftware must not be used for purposes other than those for which it was designed.

%  Theuseofthesoftware associated and other attached componentsare subjectto the terms of
thelicense provided as part of the purchase documents.

% This manual describes the maximum configuration of the software / system with the maximum
number of functions, including future options. Therefore, not all functions described in this
manual may be available in a specific system or software release.

+*  Notes and cautions are given for situations requiring special attention to prevent possible
damage and or to improve the operating procedure.

% Incorrect operation, or failure of the operator to effectively use and maintain the software and
its parts, relieves the manufacturer (and seller) from all or any responsibility for consequent
noncompliance, or damage.

% The text and graphics contained in the manual are for the purpose ofillustration and reference
only. In no event shall manufacturer be liable for any special, direct, indirect, incidental,
consequential, exemplary or punitive damages (including, withoutlimitation, any and all
damages from business interruption, loss of profits or revenue, costof capital or loss of use of any
property or capital orinjury).

|Default Username & Password:  admin|

Graphic signs in this guide

Caution Issuesthat may cause systemmalfunctions

Warning Issuesthat may cause damage to the systemor actualbodily harm

lop

Note Notes used to emphasize points and for useful operation tips
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1 Introduction

1.1 General
This guide will introduce you with the Programming Tool application, for PIMA Wireless AlarmView
and Guardian Intruder Alarm Systems, and the AVR Alarm Video Reporter.

The Programming Tool is a PC/laptop application that allows quick and effortless localand remote
systemconfiguration, including downloading and uploading of systemconfiguration settings.

The Programming Tool can be connected locally via USB, or remotely via USB-GPRS modem or
the network!.

Starting version 2.00.11, the Programming Tool now incorporates PIMA’s PIMAlink technology.
PIMAIink is a PIMA cloud service and smartphone application, that provides its users with the
secured yet convenient option of receiving push notifications and visual verification images, and
remotely controlling their alarm system from virtually anywhere.

Using the PIMAIlink technology, every control paneland smartphone application receive a
unique code and are paired with the PIMAlink cloud, to ensure maximum security without the
need for passwords and other login information.

1.1.1 Main features

The Programming Tool allows you to do the following:

. Upload and save the systemconfiguration

. Download new systemconfiguration

o Delete/add/change connected peripherals

. Upload the event log and exportit asa CSV file

. Arm and disarm the alarm system, bypass zones and more

. Check zone status and reception levels

. Create AVD customer data files to be used as templates for multiple installations

1.2 System requirements

o PC/laptop free disk space: 200 Mb
. Internet connection (for remote connection only)
. Free USB port

g
., | Make surethe port is not blocked by firewall or antivirus software.

1 Using a fixed IP address
4
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1.2.1 Operating system & configuration

Operating system RAM Processor
Windows Vista Home/Premiuny 4GB (min 1GB) 2GHz (min 1GHz)
Business /Ultimate /7, 32-bit

Windows 7, 64-bit 4GB (min 2GB) 2GHz (min 1GHz)

Windows 8 Pro, 64-bit

2 Installing & Running the Tool

To install the Programming Tool, double-click the file "Programming tool.exe”and follow the
installation wizard.

In Windows 7, if you locate the Programming Tool folder notin the default
destination (C:\PIMA), make sure other users can access it.

2.1 Running the tool

1. Double-click the shortcut icon on the desktop, or the file &J
“Programming tool.exe"” (located by default on C:\PIMA). e
2. Enterthe user name and password of the tool in the login window U o .

WIRELESS"

The Default for bothis “admin”.

Programming Tool

the Programming Tool and thealarm systems secured.

@ Changethe defaultuser name and password, to keep
See how on section 2.3.1, page 7.

3. Click OK. The main window opens up (see next)
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2.2 The main window

The Programming Tool opens up with the available Local and Remote Connection options. See the
next image andtable.

Fle  Connectio

¢ PIMA Programming Too! - Version 0200.05.00 =
ion  Admin  Help

Menu bar and | New and Open buttons: create a new customer file (AVD) or open an
File buttons existing file. See more on the next section, 2.3
Remote o SIM X Number: if you use the GSM stick to send the control panels
Connection connection requests by text messages, enter the currently active SIM
(#1 or #2) number?.
¢ Remote Access Code:enter the Access Code of the control panel?
You can connect to a control panel withoutthe Master user
approval ("Always” connection mode), only if thedefault
Access Code has been changed.
© | Remote
Connection Local and Remote Connection, Disconnect and Refresh buttons
buttons
@ | Connection Shows the connection status with the control panel:
Status e Green: connected (+ time left for session end in remote connection)
o Red: disconnected
© | Infobar The connected systemtype, the username, the IP and port

2The SIM card must be a global SIM.
3 The code must be different than the default code.

6
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2.3 The Admin menu

The Admin menu is visible only to Administrator users. It includes the following sub-menus: User
accounts, Language, Systemtype and Options.

2.3.1 User accounts

The programming tool allows creating unlimited amount of users of the application, each with one
of three permission levels: Operator, Installer, and Administrator. Here you can also change the
administrator’s name and password.

/'\ Changethe defaultadminpassword during the installation the application
°

How to configure a user

1. Fromthemenu, select Admin -> User Accounts. " “
=
2. Toset anewuser click New. L g
3. To set an existing user, click the user on the list .
. - Name arbara
and click Edit. e

. Entera user name and password for new users. Permission Level fioac] -

5. Select Permission Level fromthe drop-down list. = Gd |

The available options are:

e None: the useris disabled from accessing the Programming Tool. Use this option to
temporarily block users from the application.

e  Operator: the user can operate the Control panel only remotely, and cannot access the
Programming menu.

o Installer: the user can access the Programming menu, but cannot operate the Control
panel remotely.

e Administrator: the user can access all the menus, remotely or locally.

'WHHH}?@

N A minimum of one user must have Administrator permissions
v

6. Click OK.

How to delete a user

To delete a user:
1. From the menu, select Admin -> User Accounts.
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2. Click the desired User.
3. Click Remove.
4. Click OK. The user is deleted.

2.3.2 Language

Changing the language of the interface of the application requires restarting the application. To
change the language, do the following:

1. Make sure you have a compatible language {4/ PIMA Pragramming Tool - Version 02.00.05.00

flle (XML). File Connection | Admin | Help
- User Accounts
2. From the menu, select Admin > Nj Tonguage ][5 engish
Language and select the desired - System type Russian
language. A confirmation message in the e Comoc I, OponS i:;t:fa“e“ —
selected language will be displayed. @ S 1 (Mein) Number German

Finnish

3. Restart the application to change the
language.

SIM 2 (Backup) Numb
(Backup) Number E—]

Remote Access Code

Add Language

ﬂﬂﬂﬁﬂ{q@ e Ifthelanguage fileis incompatible with the application, an error message will

. be displayed.
g e You can add more languages. See the next subsection for details.

Adding a language

You can add any more language file. To do so, contact your PIMA distributor. After receiving the
language file, do the following:

1. From the menu, select Admin - Language - Add Language.

2. Locate the language file and click Open. The new language will now appear in the
language list.

3. Select Admin > Language and select the newly added language.
4. Restart the application to change the language.

2.3.3 System type

Because the Programming Tool is used to program three different alarmsystems, with some
parameters in use by only some, you will need to select the alarm systembefore opening a new
customer file. To do that:

1. Click New (or Admin-> Systemtype).
2. Click and select the desired systemtype.

Pima Programming Tool - System Type

. = . e s

o [N -2 (3 o HHENS eoe | W ess

. L] L] N L] L] L] L]
Guardian AlarmView AVR
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2.3.4

Options

The Options window includes the application behavioral options, mainly for the remote access
feature. To set the system options:

1.

From the menu, select Admin > Options.

Options (="
o ~T" [¥] Show Connections Wizards
Customers storage folder
C\Programmng Too Gutamers
Remote Connection
[¥] Reconnect to panel after remate write
¥| Send Connection SMS
GSM/GPRS USB Stick
GSM Stick Type Sierra Wireless -
GSM Stick Name
Test Stick
Mobile Number Send SMS - o
IP Address
Automatic - Curent PC IP
@ Manual - Fixed IP e e e e
Port
Check IP and Port
I oK [ cancel |
Figure 1 System O ptions window

The options are:

o

Show connections
wizards

Check to display the wizard every time you connect to the control
panel.

(2]

Customers storage
folder

The path to the customer files. To changeit, click Browse.

Reconnect to panel
after remote write

The control panel disconnects the communication with the tool at the
end of writing, to report it to the CMS (this action is taken even if
CMS is not set). Check this option so the control panel will
automatically initiate a new session with the application right
afterwards.

Send Connection
SMS

Check this option so the Programming Tool will automatically send
(via the AirCard stick, if being used) a text message with connection
request to the control panel.

If left unchecked, you will have to manually send the SMS from any
mobile phone, or use the IP Receiver to sendit.
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O [GSM/GPRS USB . Stick Type: If being used, select the stick from the drop-down
stick list: Sierra Wireless (recommended) Vodafone Huwaei, or any
generic USB-GPRS modem.
Using a generic GSM stick that have not been tested
and found to comply with our standards may cause
various malfunctions or not function atall. Note the
stick mustcarry a global IP address.
. Stick Name: enter a name to recognize the stick on text
messages
© | Test Stick To test the GSM stick*:
a. Entera Mobile phone Number.
b. Click Send SMS. A test message will be sent to the mobile phone
If the message is not received, check the phone number. If the
number is correct, check the stick.
IP address . Automatic: check this option so the application will use the
PC/laptop’s IP address.
(6 . Fixed IP: enter a fixed IP address as the application’s address.
Port Enter the port no. in use by the Programming Tool. Make sure the
portis not blocked by any firewall/anti-virus software.

2.

Click OK to save the changes and close the window.

4 Use a stick with a global static Internet IP address.

10
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3 The Tabs

The Programming Tool has five tabs: General, Options, Actions, Status, Time & Date, and
Programming. Only the Generaland Programming tabs are available before connecting to the
control panel.

3.1

General

After selecting the system type (see section 2.3.3), the Generaltab is opened.

New Open

i 7 Genenal

ptions

Programming

i Pima Programming Tool - Version 02010400

File Connection Admin  Help

H R ¢ @

Save Save As Locale Remoto

- (1)

FRemote Connection tha

SIM 1 (Main) Number

SIM 2 (Backup) Number 9

Remote Access Code 531502

System type: AlarmView | Username: Admin | IP: 192116240154 | Port: 9983 |

Courtry
Emai

£nd of Marterance

System Version 02.10.03.00.000 Wireless frequency 868 635 MHZ
Active Language engish Wirsless verson ADgA
Actrve System Type Aamiew 0

Figure 2 The main window
© |CustomerName | Enter the name of the customer. This hame, along with the customer
ID will serve as the customer filename.
® [Remote 1. Enterthe phone number/s of the control panel, for sending
Connection connection requests text messages to the control panel by the
AirCard stick. Leave blank otherwise.
2. Enterthe Remote Access Code of the control panel®.
© |Customerdetails |Enterthe details of the customer.

5 Youcan connect to a control panel without the Master user approval ("Always” connection mode is enabled at
the control panel), only if the default Access Code has been changed.

11
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@ | The connected . System Version: the connected control panel’s version
control panel e  Active Language: the GUI's language
details . Active SystemType: the selected system(Admin-> SystemType)
. Wireless frequency: the connected control panel’s frequency
o Wireless version: the version of ST-1 card
© |Infobar Information on the connected control panel and the Programming Tool

3.2 Options

[ Pima Programming Tool - Version 02.01.04.00 = | E] S
File  Connection Admin Help
) AN & @ % 5
j [t H H ¢ x = Local Connection
New Open Save Save As Local Remote Discomect  Refresh
> ) -
@ Gobacams b Comac! [Ebesets -
[+ ] R
T Remote Look-n Y Contact2  [PIMAlink backup .
8l e
E Visual Events Contact 3 | Disabie alerts v
-
Ste R
b comestt ubzozte =
n‘ ot [pameae -
- .
- @p Cortoct® [Disable alris -
System type: AlarmView | Username: Admin | IP: 192116.240.154 | Port: 9983 |
Figure 3 The O ptions tab

The available options (only when connected) are:

System Options | Select/deselect to enable/disable the options.

Contacts For every contact, select the options for receiving systemnotifications,
including via the PIMAlink app.

Set Click the button to write the settings to the control panel.

12
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3.3 Actions (Remote Connection)

L+ PIMIA Programming Too! - Versian 02000500 = |
fe Comecion Admin Help

H I’ # @ x - Remote Connection
Soe ek a iz Daceven  Rew s
2ame typass

{4 Genoral

Optors. Lew

1]

B Actions DISARMED

O sts.

Zone ¢ Zone 14 Zone 24

|
|
‘ Zomed Zoma 13 Zome 23
|

% Tirme & Date Zones Zome 18 Zone2s

Zona 6 Zoma 18 Zona 26

Il

Frogramming

Zone 10 P— Zone
-
- | Sat
L
Figure 4 Actions tab

The Actions menu is only available in remote connection. This tab allows you to arm and disarm,
bypass zones and stop the siren. The available actions are:

System Click to Arm the control panel to one of the arming modes, or Disarm it.
State The systemstate is reflected in the colored area and label.
Event Log Click Read to upload and save the control panel's log as CSV file. When
you will open the file®, you will see the log. For example:
12 |01/01/2010 14:03 AC Loss System (AlarmView)
13 |01,/01/2010 12:00 Backup SIM failure SIM not inserted
14 |01/01/2010 12:00 System Programming  System (AlarmView)
15 |01/01/2010 12:00 End System Prog System (AlarmView)
Other Stop siren and stop communication options
Zone Bypass | Select zones to be bypassed and click Set to write it to the control panel.

@ ¢ Itmay take 10 sec. until the action is performed and status is updated correctly
/]/ e To change the arming state from one mode to another (for example: Away to
{ Home), disarm the control panel first

6 Use Microsoft Excel® or any text edit software, like Notepad®.
13
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3.4 Status
Pima Programming Tool - Version 02.00.09.10 0001 .avd - OEEN
Fil Connecti Admis Help
] 7 = 5 ® o = Remote Connection
w Open Save fe Femse  Docomed  Reoh Time left: 00:11:28
Copripone
o
Bosiup Batery 1] e Taper . porer [
s A Jil s isws @ wasas @
Zorws ual Zones
R - o SHOATIH
Zoe Zoe 13 Zna 23 ] |
Zne s Ty | Zome 1 3
s
Zene Zone 1 Zone 24 i il
Zone 6 Zone 16 Zore 20 nd]lD_-w ]
o7 JHIOATEE 2~
Zone. Zone 18:
Zune Zane 15
Zore 10 Zora 20:
Systemtype: Alamiiew | User name: admin | P: 192162000193 | Port: 8330
Figure 5 Status tab

The Status tab shows the connected system's and available zones’ status in colorful icons. To
refresh the status, click the Refresh button, up on the connection bar. The available control panel
icons are described in the next table.

Icon Description State
System [ Q@] Backup Battery Full, Low, Disconnected
TT Panel Tamper Open (alarm)/Closed (normal)
78 AC power On/Off
Communication 1] 12 Active SIM -
_E]UH_ "l | GSM receptionlevel | No reception/Good
B EE SIM mode Single/Dual
v RéE SIM X Status OK/Not inserted/Faulty
Normaland Ei % | RrsSI level No reception/High
Visual Zones 1) Battery Full, Low, Discharged
4L .. | chime On/Off
T T Zone Tamper Open (alarm)/Closed (normal)
B B Zone bypass Bypassed/Un-bypassed (normal)
RN Zone state Open/Closed

14
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3.5 Time & date

# PIMA Programming Tool

i A General Tene
LN = " ® 2um

Awem

—
B rcrons St
‘ june, 2013 ’ © 00 /MM

MM /0D

Figure 6 Time & date tab

The Time & Date tab allows setting the control panel’s current time (only when connected):

1. Setthe time manually, OR
2. Click Get PC Time to get the PC/laptop current time.
3. Click Set to write the settings.

3.6 Programming

See the next section for details.

4 Programming

Clicking Programming opens up the programming window, with the Zones
tab selected. The window is divided into three sections, as shown in the
following figure, and detailed below.

The Programming window can be open at any time, without being connected
to a control panel.

15
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Programming =]
o__ = = v L]
Save Save & Close. Read Write oK Cancel
‘ Zone# | Enabled D Name Zone Type Away Home Patial Sren Chime Force Am sf‘mfm
Il DIET9B0CK |1 Etry/Ext - ] [Mter 3 aloms | ~.
g Wired Zones 2 5802103%%X |2 Entry/Exit - [a] After 3 alams |~
3 01A2983OX |3 Entry/Bxit - [a] Ater 3 alams |~
- 4 7231000 [4 Entry/Ext - fiter 3alams |~
‘ [ Visual Zones ‘ 5 AR |5 Nomal - [Ater 3 aloms_|~.
3 =] 1829101XK% |6 Normal - Ater 3 alams |~
%,Y ?3;”;3’ 7 ED0S4FEXXK |7 Fire - After 3alams | v
— g E | coottomox |8 Normal B B |Merdolams |~
f Panic Butions. ] i) B38EIBINX |9 Normal - B After 3alams |
10 i} 378E9BIOX |10 Normal - ] Ater Jalams |~
_ n ] CBEAIBIOX | 11 Nomal 2 [ |Ater 3alams |~
e —“‘))) Siren ‘ 12 = 2FBIBION |12 Normal - [ |Ater3alams |+
13 s} 059798300 | 13 Normal - ] Ater 3alams |~
14 [&] AE2R10TOK | 14 Normal - B Mfer 3alams |~
P — et
B 7 ] FD201010CK | 17 Normal - O |Ater3atoms |~
48 User Contacts ‘ i [&] 729898300 |18 Nomal - [ [ter3alams |+
13 =] D1291030 |18 Nommal - [ |Mter3alams |~
‘ﬁ* CMS Contacts ‘ Fl =] GEBBIBIOOC | 20 Normal - ] [ Ater 3 alams |~
21 =] CT261010 |21 Normal - B After 3alams |~
‘ El Communication 2 i) 9BDBOF 10X | 22 Normal - ] Ater 3 alams |+
-~ 2 [&] BA144FA0OX | 23 Medical - B Mier 3alams |~
‘ /‘System Options 6
Figure 7 The Programming window
© |Command Save | Save the current configurations (modified or not) to a file (AVD).
buttons Save & . ] ]
Close Save the current configurations and close the window.
Read | Upload the configurations of the connected control panel.
Write | Download the configurations to the connected control panel.
OK Temporarily save the current configurations and close the
window. If you exit the Programming Tool without saving the
configuration to a file or downloading it, changes will not be
saved.
Cancel | Close the window without saving changes. A pop up message
will ask you to confirm this action.
® | Programming | Click each group to set its configurations. The groups match the control
groups panel’s menu.
© |Parameters |Setthe configurations of the connected alarm system. See each system's
area Installation Guide for complete details.

4.1

Tt | B °
1 0000000
2 0000000
ired Zones
3 71 |ooooooo.
4 (] 0000000
5 71 | ooooooo.

Name
FRONT DOOR
LIVING ROOM
BED ROOM 1
OFFICE
FIRE

Figure 8

Zone Type

Entry/Exit

Normal

Normal

Normal

Fire

K

Wireless and wired zones’

EISIEIEE] 1

<

Home

0= oo

Zones configurations

7 See the product’s installation guide for full details on each option.
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Siren

Chime

0OooooeE

Force
Arm

[m]
]
]

Swinger
Shutdown

| After 3 a.

After 3 &

| After 3 a.

<

After 3 &

<

| After 3 a.

<
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<l

@ Zones Zonett Ediud‘ Name |Zrl|:Type ‘ |M|Pmd‘§m‘ﬂm‘mm|m
— [ |zonezs |Nomai I~ | | | ™ [ B | O |ser3amms v

Figure 9  Wired zone

4.2 Visual zones

Zone# Enabled 1D Name Zone Type \6':”",“' t“? s‘:’;’;ﬁ:ﬂ
00000... |VISUAL ZONE25 Nomal  |v [ |ater3a.. |v
26 | [] |00000.. VISUAL ZONE26 Normal ~ [ |afteraa.. |~
i Visual Zones | 27 [] |00000.. VISUAL ZONE27 Normal ~ [ |atter3a. |~
28 [] | 00000... VISUAL ZONE28 Normal ~ [ |atter3a. | v

Figure 10 Visual zones configurations
4.3 Keyfobs and keypads

 Enabled D | Name
L4 0000000 | KEYFOB/KEYPAD1
F]

0000000... |KEYFOB/KEYPAD2

' IHH!-: ! a | |0000000. . |KEYFOBMEYPAD3
4 0000000.... | KEYFOB/KEYPAD4
5 0000000 | KEYFOB/KEYPADS
8 0000000 | KEYFOB/KEYPADS

Figure 11 Keyfob and key pads configurations

4.4 Panic buttons

Panic# Enabled D Name: Type |
] 0000000... |PANICT Medical |~

2 0 0000000... PANIC2 Medical
3 ] 0000000... PANIC3 Medical >
6 Panic Butions
L ‘ 4 ] 0000000... PANIC4 Medical >
5 ] 0000000... PANICS Medical >
6 ] 0000000... PANICE Medical >

Figure 12 Panic buttons configurations

4.5 Sirens

o3 Ext Siren Options (Away)
[] Enabled D don0an [ Arming Tones
Cutoff (sec) 60 Start Delay (Sec) 0 [7] Entry/Bxit Tones
Internal Siren
Enabled
Cut Off (Sec.) 80

Figure 13 Sirens configurations

17
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4.6 Passwords

[¥] sMS Remote Commends

¥] MMS Remote Look-in

"] Emeil Visusl Events

User 1
Name Usar 1 Password ¥ Remote Commands
User 2
Neme User2 Password ¥ Remote Commands [¥] Remote Look-In
User 3
Name User3 Password ¥ Remote Commands.
User 4
Neme User4 Password ¥ Remote Commands [¥] Remota Look-In
User 5
Name UserS Pasaword ¥ Remote Commands
User
Name User§ Password ¥ Remote Commands. |¥| Remate Look-in
4-8 digit passwords, numeric values 1-4 W
’ Duress Code
Password
@ Master User
8 T Passaord
x Installer
g Password 1234 Access Mode
Figure 14 Password configurations
4.7  User Contacts
System Event Report
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Figure 15
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4.8 CMS Contacts
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Figure 16 CMS Contacts configurations
4.9 Communication
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Figure 17 Communication configurations
4.9.1 Custom operator parameters

You can define up to four new operators, in addition to the default list of operators. The
operator/s will be added to the Operator drop-down list on the left pane. To add an operator:

1. Obtain the required data from the cellular operator.
2. Fill the relevant fields.

3. PressSave at the top to save the new operator. The new operator/s can be found by
selecting “Custom” from the Country drop-down list on the left pane. After testing the
communication you can send PIMA the XML file to permanently include the new operator/sin

the control panel’s operators list.
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4.10 System options

5.1

To connect to the control panel locally, do the following:

1.

Entry/Exit Options

Entry Delay (Sec.) 30

Exit Delay (Sec.) 30

Toes —
Remote Access

Access Mode User Initiated he

Access Code
‘System Options

Supervision Optians

I - —

PGM

Arm/Disarm
Forced Arm
One Key Arming

[ wireless Keypad Only

Overriding Prevention
|| Backup Battery Loss [ | AC Loss
[] Zone Supervision Loss
[] sim Faults

System Lock-Out

Dealer Lock-Out

Master Prog. Lock

Trigger Inputs

Trigger Upon Builtn Siren Follower + Triggert

Output Type Steady (Normally Op Trigger2

pus T e T —
Figure 18 Sy stem O ptions

How to connect to the Control

Panel

Local connection

Click the Local connection button, up on the connection 3 & ® e
toolbar and follow the wizard® to connect to the Control Local Remols  Disconnect  Refresh

panel. If the connection wizard is enabled,

If you prefer to connect without using the wizard, do the following:

a. Inthe controlpanel, press Menu, enter the Technician code and select
Programming - Local Programming and click OK.

b. Connect the control panel to the PC/Laptop with an

A-B USB cable.

c.  Wait for the computer to recognize the control panel
(a message will be displayed on the taskbar).

When connection is established, the connection status

turns green.

In the window that opens up, click Yes to read
the control panel’s configuration first.

8 See section 2.3.4, on page 8 for details
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How to connect to the Control Panel

5.  Whenyou're done with programming, click the ®
Disconnect button up on the connection toolbar.

Disconnect

§
¥ [ After disconnecting from the control panel, set the system time.

5.2 Remote connection

Before you connect remotely, make sure you enter the Remote Access Code on the General tab
(see section 3.1, onpage 11).

To connect to the control panel remotely, you need to send the IP address and port of the
Programming Tool® to the control panel - that is the initiator of the call session. To do so, you
have several options:
a. Send SMS from any mobile phone: send the control panel a text message with the IP
address and port no. of the Programming Tool, in the following syntax: "R space IP
address space Port, for example "R 236.154.1.5 8888".
1. Make sureany Firewallis notblocking the port from internet connection.
@ 2. ThedefaultRemote Access Code mustbe changed for the Programming

Tool to connect to the alarm system.

3. Whilerunning the Programming Tool, the PC/laptop’s network adaptor
must bedisabled -see AppendixB,on page 24 for details.

b. Automatically send text message using a GPRS stick (if in use). See section 2.3.4, on
page 9 for details.

c. Send a connection request by the IP Receiver?®.

Immediately after sending the connection request, do the following:

1. Click the Remote connection button, up on the connection p ®
toolbar. Local Remote Disc

2. Wait for the Programming Tool to establish the connection.
The connection status will turn green. If connection is not
established within 90 sec., repeat the process.

3. The remote connection timeout is 20 min. The session will be terminated when this time is up
(a one minute to disconnection warning is displayed).

Remote Connection
Time left: 00:19:16

4. Inthe pop up window, click Yes to first read ]
the control panel’s current configuration, before A Would you like to read Panel's configuration first?
making any changeto it. =

9 If the PC/laptop with the Programming Tool is connected to the net through a router, you need to Port
Froward the communication to the PC/laptop. See the “Limited Support Notice” at the end of this guide.
10 See a separate guide P/N 4410388.
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6 Read, Write and Offline Programming

6.1 Reading parameters

To read (upload) the parameters from the control panel:
1. Click the Programming tab.

2. Click the Read buttonse= . The Read button icon will now appear as disabled. Wait until the
icon is enabled and the parameters under the Programming tabs are updated with new ones.
The process may take several minutes.

3. Savethe uploaded parameters in your database, by clicking the Save or Save & Close
buttons.

6.2 Writing parameters

To write (Download) to the control panel:
1. Click Programming tab.
2. You can either set the various system parameters and download them immediately, or click
Open to open a previously saved data file (AVD).
*

3. Click the Write button w«. The Write button’s icon will now appear as disabled. Wait until
writing is completed and confirmed. The process may take few minutes.

6.3 Offline programming

You can set the various parameters in the Programming Tool, before connecting to the alarm
system(for example, at the office), save them, and download them later on when you connect to
the system.

To create a new datafile:

1. Onthe Main window, click New in the toolbar (or select File > New).
2. Setthe desired parameters, including those in the Programming menu.
3. Click the Save button and save the newly createdfile.
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Appendix A Sierra GPRS stick installation

This section describes the installation and configuration of the recommended Sierra GPRS Stick.

An online tutorial of the manufacturer can be foundin the following link:
http://www.sierrawireless. com/resources/images/demos/aircardwatcher2010.swf

Full Installation guide:
http://www.sierrawireless. conySupport/Downloads/AirCard/Legacy Products/~/media/Support D

ownloads/AirCard/docs/UG/2130961 Compass _USB_modems_Installation Guide.ashx

To install the stick:
Insert a SIM card into the GPRS stick. Ensure proper direction of the card.

Insert the GPRS Stick into an available USB port in the  /__# M
PC/laptop. If a Windows security window appears, click s : =

- Welcome to Sierra Vilreiezs TRU-ntell
Cllk 0K to nstall 36 Warcher

1.
2.

10.

Yes.

The Sierra installation wizard opens. Follow its steps
carefully to install the application.

Once completed, the AirCard Watcher application will
open automatically. As soon as cellular link is
detected, the Watcher’s window is minimized to the
tray.

Check the cellular signal quality - it should be green

s

and indicate with as much as five indicators il , BE

SIERRA
WIRELESS

Open the User option screen and make sure the Routing option is set to: Circuit Switched.

& User Options - @@
2] General
(< Messaging > General
L. Network Service center number +972521100059
ST Sebtings Defaul destination number
@ PS“O‘“ ‘:’ Routing option Circut Switched )
L iy Jme —— Pop-up notification Disabled
Outgoing Messages
Vahdity period Weeks
Weeks s
Dekvery confirmation Disabled
Messaging
Figure 19 AirCard Watcher User O ption screen

In the Programming Tool main screen (General), enter the correct System Phone Number
and Remote Access code. If you need to check the two parameters in the control panel:

a. Accesstheinstaller menu and select Programming - System Options >
Remote Access.

b. Check that the Access mode is set to either Always or During Disarm.
c. Check that the Access code matches that of the programming tool.
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Appendix B How to disable the network
adaptors

For the Programming Tool to run, make sure all the network adaptors are disabled in the
PC/laptop: WLAN, LAN and/or any additional network adaptor must be disabled, during the use of
the GPRS-stick and the Programming Tool.

Open Network Connections by clicking the Start = Control Panel > Network and Internet
- Network and Sharing Center > Manage network connections.

Right-click the network adapter, and click Disable. If you are prompted for an administrator
password or confirmation, enter the password or provide confirmation:

After finishing working with the Programming Tool, you have to enable the network adaptors to
connect to a network.

@Q?‘ & » Control Panel » MNetwork and Internet » Network Connections »

Organize = Disable this network device Diagnose this connection Ren:

l:. Local Area Connection
=== _ domain.local T
7 Intel®) 82579LM G ¥ Disable L
Status
Diagnose
% Bridge Connections

Create Shortcut
Delete

Rename

% Properties

Figure 20 Disabling network adaptors

Appendix C Troubleshooting Remote
Connection

Following is a list of actions you can take in order to troubleshoot remote communication failures.
There are many reasons why the remote communication might fail, and before contacting PIMA
support, review the following actions, which most likely will resolve any communication erroryou
may encounter.

HHtS

/7 Testthe communication after each step described below, and only move on to the
(| next step if the communication is still not establis hed.

1. Make sure the control panel’s phone number and access code are identical to those in the
control panel; see section 2.2, on page 6.

2. Ensure that the remote connection option is enabled in the control panel: access the Installer
menu and select Programming - System Options > Remote Access > Access Mode.
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v o

L N

11.

12.

Make sure the IP address is correct.
Add an exception to the firewall for the Programming Tool, the port, and IP address.

Turn the firewall completely off. Make sure to turn it on again once you finish using the
Programming Tool.

Restart the computer.

Ensure that all the network adaptors and connections beside the GPRS stick are disabled.
Check the connection to the cellular network: make sure that the signal level is strong.
Attempt to open any web page online and try to ping another PC/laptop.

. Test the stick's SMS capability, by sending a test SMS. If you don't receive the message,

check the SMS options in the control panel to see if the send and receive messages option is
enabled: access the Installer menu and select Programming - User Contacts >

Contact X-> Options.
Check the AirCard Watcher application to see its status
and ensure that the adapter is connected properly.

Check that the GPRS stick drivers are installed properly
and reinstall the application if necessary.

£a" AirCard Watcher =[]

No device detected

SIERRA

WIRELESS®

Figure 21 Stick
detection error

If none of these steps helped, contact PIMA technical support for further assistance.
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Appendix D Limited Warranty

PIMA Electronic Systems Ltd. ("the Manufacturer") warrants its products hereinafter referred to as "the
Product" or"Products" to be in conformance with its own plans and specifications andto be free of defects
in materials and workmanships under normal use and service for a period of twelve (12) months fromthe
date of shipment by the Manufacturer. The Manufacturer's obligations shall be limited within the warranty
periodand itsoption, to repairor replacethe product or any part thereof. The Manufacturer shallnot be
responsible for dismantling and/or reinstallation charges. To exercise the warranty, the product must be
returned to the Manufacturer freight prepared and insured.

The warranty does not apply in the following cases: improper installation, misuse, failure to follow
installation and operating instructions, alteration, abuse, accident or tampering, and repair by anyone other
than the Manufacturer.

The warranty isexclusive and expressly in lieu of all otherwarranties, obligations or liabilities, whether
written, oral, express or implied, includingany warranty of merchantability or fitness for a particular
purpose, or otherwise. Inno case shall the Manufacturer be liable to anyone for any consequential or
incidental damages for breach of thiswarranty orany other warranties whatsoever, as aforesaid.

Thiswarranty shall not be modified, varied or extended, and the Manufacturer does not authorizeany person
to act on its behalf in the modification, variation or extension of this warranty. This warranty shall apply to
the Product only. All products, accessories or attachments of others used in conjunction with the Product,
including batteries, shall be covered solely by their own warranty, if any. The Manufacturer shall not be
liable for any damage or loss whatsoever, whether directly, indirectly, incidentally, consequentially or
otherwise, caused by the malfunction of the Product due to products, accessories, or attachments of others,
including batteries, used in conjunction with the Products. The Manufacturer does not represent that its
Product may not be compromised and/or circumvented, or that the Product will prevent any death, personal
and/or bodily injury and/or damage to property resulting from burglary, robbery, fire or otherwise, or that
the Product will in all cases provide adequate warning or protection. User understands that a properly
installed and maintained alarm may only reduce the risk of events such as burglary, robbery, and fire
without warning, but it is not insurance of a guarantee that such will not occuror there will be no death,
personal damage and/or damage to property as a result.

T he Manufacturer shall have no liability forany death, personal and/or bodily injury and/or damage to
property or other loss whether direct, indirect, incidental, consequential or otherwise, based on a claim that
the Product failed to function. However, if the Manufacturer is held liable, whether directly or indirectly, for
any loss or damage arising under this limited warranty or otherwise, regardless of cause of origin, the
Manufacturer'smaximum liability shall not in any case exceed the purchase price of the Product, which shall
be fixedas liquidated damages and not as penalty, and shall be the completeand exclusive remedy against
the Manufacturer.

Warning: The user should followtheinstallation and operation instructions and among other things test the
product and thewhole systemat least once aweek. For various reasons, including, but not limited to,
changes in environmental conditions, electric or electronic disruptions and tampering, the Product may not
performasexpected. Theuser isadvised to takeall necessary precautions for his/her safety andthe
protection of his/her property.

* Patent Pending T echnology
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Limited network support notice:

Due to the diverse mix of networks, we are not able to offer support on routers, modems, switches or any
other network/intemet related devices or services.

Our support forinternet or network related features, that are not directly related to the product are limited.
T he following must be completed before calling our support team with network/intemet related features:
a.  Your network/intemet must be configured and working.
b. 1P addressand port number forthe product must be pre-configured on thenetwork.

c.  Also have the following information available: default Gateway, Subnet mask, port numbers and
all other network information.

Limitation of Liability

In no eventshall PIMA or its’ suppliers be liable for any consequential, special, incidental, orindirect
damages of any kindarising from thedelivery, performance, or use of the software, including loss of profits,
loss of business, loss of data, or loss of use, system crash, disk/system damage, regardless of the formor
base of action.

These limitationsapply evenif PIMA has been advised of the possibility of such damages and regardless to

the formof action, whetherfor breach of contract, tort, product liability or any other theory of liability. In no
event will the aggregate liability of PIMA or its suppliers for any claim, whether for breach of contract, tort,
product liahility or any other theory of liability, exceed the greater of US$1.00 or license fee paid by you.

Youagree to the allocation of liability set forth in this section and acknowledge that without your agreement
to these limitations, the fees charged for the license would be substantially higher.
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Appendix E Declaration of Conformity

Hereby,

Company: PIMA Hectronic Systems Ltd

Address: 5 Hatzoref Street, Holon 58856

Country: Israel

Telephone: +972.3.6506414

Fax: +972.3.5500442

PIMA Electronic Systems Ltd. declares that the AlarmView systemis in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Federal Communications Commission (FCC) Part 15 Statement

This equipment has been tested to FCC requirements and has been found acceptable for use. The FCC requires the
following statement for your information.

This equipment generates and uses radio frequency energy and ifnot installed and used properly, that is, in strict accordance
with the manufacturer’s instructions, may cause interference to radio and televisionreception. It has been type tested and
found to comply with the limits for a Class B computing device in accordance with the specifications in Part 15 of FCC
Rules, which are designed to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation. Ifthis equipment does cause interference to
radio or television reception, which can be determined by turning the equipment offand on, the user is encouraged to try to
correct the interference by one of the following measures:

If using an indoor antenna, have a quality outdoor antenna installed.

Reorient the receiving antenna until interference is reduced or eliminated.

Move the receiver away from the control/communicator.

Plug the control/communicator into a different outlet so that itand the receiver are on different branch circuits.

If necessary, the user should consultthe dealer or an experienced radio/television technician for additional suggestions.

The user or installer may find the following booklet prepared by the Federal Communications Commission helpful:
“Interference Handbook™. This booklet is available romthe U.S. Government Printing Office, Washington, DC 20402.

The user shall not make any changes or modifications to the equipment unless authorized by the Installation Instructions or
User’s Guide. Unauthorized changes or modifications could void the user’s authority to operate the equipment.

RoHS compliance - All our productsarelead-free 1
PIMA Electronic Systems is ISO 9001 certified

O CEFC rors

All data contained herein is subject to change without prior notice.

PIMA Electronic Systems Ltd.

* Patent Pending Technology

This guide and the information contained herein are proprietary to PIMA Electronic Systems Ltd. Only PIMA Electronic
Systems Ltd. or its customers have the right to use the information.

No part of this guide may be re-produced or transmitted in any formor by any means, electronic or mechanical, for any
purpose, without the express written permission of PIMA Electronic Systems Ltd.

PIMA Electronic Systems Ltd. owns patents and patent applications, trademarks, copyrights, or other intellectual property

rights covering the subject matter in this guide.

The furnishing ofthis guide to any party does not give that party or any third party any license to these patents, trademarks,
copyrights or other intellectual property rights, except as expressly provided inany written agreement of PIMA Electronic

Systems Ltd.

Copyright © 2016 by PIMA Electronic Systems Ltd. All rightsreserved. E&OE
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